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1. Introduction, Functions

The observation of weather data does not only have global meaning but can also 
be of interest locally. This can extend from a simple display for the current weather 
data to long-term observation and analysis of recorded weather data right up to 
reaction to the exceeding certain high and low values. The radio weather station 
makes all of this possible in connection with operating and evaluation software. 

When the weather station records all weather data, the data can be read and 
analyzed with the operating and evaluation software. All measurement values 
from the sensors are automatically sent to the weather station and stored there 
for this purpose. The weather station is then connected to a free USB interface. 
The data can then be transferred into the PC with the software.

The radio weather station is therefore able to provide comfortable and extensive 
observation and analysis of weather data and also makes a reaction to certain 
weather conditions possible.

The functions of the "WeatherProfessional" software
- 	Reading the data collected from the weather stations WS 300 PC-US/WS 500 

US/WS 550 US through the USB port
- 	Display of the current weather data in a graphic weather display
- 	Graphic and statistical preparation of collected weather data and optional 

display as progressive graphic or as a table
- 	Detailed evaluation of the weather data in a progressive trend graphic by cur-

sor-scanning the graphic
- 	Complete flexibility, which weather data should be displayed with which pa-

rameters, e.g. time periods, sensors, min./max. values, etc.
- 	Saving all recorded data in a professional database
- 	Saving the current display as an image
- 	Defining the start-up screen of the display
- 	Control and management of all sensors involved
- 	Firmware update possibility of the interface
- 	Easily operated control center for all relevant settings of the program
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The following system prerequisites apply for operating the "WeatherProfessional"  
software:
· Operating system Windows 2000/XP/Vista (only 32 bit) this software does not 

support XP Media Edition
· Min. 1 GHz clock frequency
· Min. 256 MB RAM
· Approx. 150 MB available hard disc space for the program
· Approx. 100 MB available hard disc space for the database
· The file system must be formatted with NTFS (Standard option)
· The Windows-Installer-Service must be installed (Standard option) 
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2. Operation
2.1.	 Program Start Software installation
1	 Insert the Weather Professional disk to computer and load software with 

Install Aware Wizard. 
	 Note: Complete installation is most common. Personalized /installation is for 

customers choosing a different drive to load the program into.
2	 Connect the weather station with the provided USB cable to a free USB port 

of the computer. Be sure it is connected firmly into the base station.
3	 Start the program Weather Professional from the desktop or from the program 

folder.
4	 During the program start, the database is configured automatically, the 

program window will appear.
5	 Shortly afterward the graphic weather display appears with the current 

weather data and the weather forecast in the form of the Oscar Outlook.
6	 The program will read the data of the interface automatically. This may take a 

few minutes. The bottom part of the navigator (in the lower left of the program 
window) shows the time period for which the weather data has been saved 
and transferred to the PC.

7	 Now select the time frame that should be used in the data evaluation from 
this time period. 

	 You have three options:
1.	Enter the desired time frame directly in the format Day. Month name Year 

Hour: Minute.
2.	Select the desired date with the Arrow Keys on the right next to the entry 

line
3.	Select the day and month directly from the calendar, which opens by 

clicking on the calendar symbol on the right next to the entry line.
8	 Select button ‘Accept‘. The program now takes the weather data for the 

selected time period and you can evaluate the information immediately with 
the basic program configuration by selecting one of the predefined weather 
displays or weather history on the left in the navigation field.

Notes
The display that was present at the time the program was ended appears
again when the program is started.
All of the data that is read is automatically stored in the database and is
available for data evaluation at any time.
The data is also retained through updates or after reinstalling the „Weath
erProfessional“software.
If your computer is running with a firewall, access to the data is to be 
enabled as indicated in the operating manual for the firewall and otherwise 
error messages will appear when trying to access the database. The 
enabled port can be accessed locally only.
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2.2. The user interface
The main window for the operating and evaluation software consists of a menu 
line (1), a tool bar (2), a status bar (3), the display field for graphic or table displays 
of the individual measurement values (4) and the navigation area (5).

Menu line (1)
The menus for control of the software are arranged in the menu line.

Tool bar (2)
Menu points from the menus that are used more often are arranged in a tool bar 
for faster access with a mouse click.

Status bar (3)
The progress of the data import process is shown with a progress bar and a 
counter for the data records that have been read here.
A connection symbol indicates a good connection with the interface in the status 
bar on the right-hand side of the main window. 
If the connection is faulty, the symbol is crossed through with a red line.

1 2 5 4

3
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By clicking on the symbol, the connection status appears in a text field.
To the immediate left, the current climate comfort factor at the weather station 
location is displayed. Respective explanations are provided in the appendix.
To the immediate left of the climate comfort display, the current moon phase is 
shown.When selecting one of the three display fields, additional information on 
the display is shown in another window.

Display field (4)
Either the weather display can be shown with the current weather data or the 
data that has been read is shown in tables or graphic format (weather history) 
in the display field.

Navigation area (5)
In the top part of the navigation area, the weather displays or the weather history 
to be displayed in the display field can be selected. 
The data to be displayed is selected in the lower part. 
You can select which time period and which sensors should be shown.

2.3. The control center
Numerous program settings, determining the interface status, working with 
the database and many general program settings can be handled through the 
control center. This control center is accessed from the various menu points of 
the menu and tool bars, which is why we will get to know it first.

- 	Use the mouse to go to the "Tools" menu and open the "Control center" menu 
point. The "Control center" is opened.

	 As an alternative, you can go to one of the displays in the display field or an 
entry above in the navigation bar with the mouse pointer and then press the 
right mouse key. "Settings" appears. Actuating the right mouse button again 
also leads to the control center.

2.3.1. General
- 	If you open this sub-menu, you can make the following basic settings:
Language -	 Select the program language
Look and Feel - 	 Select the appearance of the user interface
Location - 	 Entry of the current location (for sun-rise and sunset, 
	 see 2.6)
Miscellaneous - 	 · Switch the tool bar/status bar on or off
	 · Synchronize the clock on the weather station with the PC
	   time	
	 · Firmware version display	
	 · Automatic memory cleanup 	  
	  (important for the stucture of the database in long-term 
	  operation)
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2.3.2 Database
- 	 All settings that concern the interaction between the program and the installed 

database are made in this sub-menu.

Note!
For working on the 
database (maintenance,
backup, save/load etc.)
you must have
administrator rights 
for your computer!

Database connection
Test connection - 	 Here, you can determine whether the program 

is maintaining a proper connection with the 
database by selecting the button "Test con-
nection". 

Service 	 The data stored in the database is maintained 
here.

Backup database - 	 This button is used to store a backup copy of the 
data stored in the database to another storage 
location. This backup should be done regularly 
and to an external storage device.
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Restore database -	 This button can be used to restore the content 
of a possibly destroyed database to the point in 
time of the last backup (see above).

	 After actuating the button, a warning message 
appears indicating that all of the data stored to 
that point in time can be lost.	 That means 
that after the restore, only the data from the 
backup will be available.	 If you want to continue 
with the restore procedure, click "OK". The de-
sired backup can then be selected and loaded 
to restore the database.	

	 After the restore, a message appears indicating 
completion and a request for maintaining the 
database.

Maintain database - 	 Database maintenance should be performed reg-
ularly and immediately after a program request 
to maintain the integrity of the data, the access 
speed and the consistency of the database.

	 Actuate the button "Maintenance database". A 
completion message appears after the mainte-
nance procedure.	

	 Actuate this with the "OK" button and leave the 
database with the OK button.
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2.3.3 Weather history (Weather diagram)
- All settings for the start-up screen of the weather progress graphic can be 

made in this sub-menu.

In the top part, color settings and other display settings can be made and the 
lower part is for defining the respective scales.
Every definition can be accepted and checked immediately with the "Accept" 
button at the very bottom as long as the weather history has been selected as 
the main display previously.

"Display" configuration field

Background color 1 - 	Defines the first color of the background color progres-
sion (Margin color around the diagram ("Chart"); the 
selection is made from the color scale opened by click-
ing the button "...".

	 Here, you have the choice of various color systems 
	 (Windows color palette, HSB, RGB).
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	 The selected color is shown in the preview field so that 
the effect can be seen immediately.

	 With "OK", the setting is accepted in the display menu, 
"Reset" clears the selected color and returns to the 
previous color and "Cancel" aborts the color selection 
without making any changes.

Background color 2 - 	 Definition of the second background color, set the same 
as for "Background color 1".

	 The results of the selected progression can be seen 
immediately in the "Preview" color field.

Background color chart - 	Color selection for the chart background, procedure the 
same as "Background color 1".

Background image - 	 Here, you can select your own image in .png, .jpg or 
.gif format and use this as the chart background. After 
actuating the button "...", the Windows file selection 
appears and you can search for and load the desired 
image. The image name appears in the previously empty 
name field. Button "Delete image" will delete the image 
and the selected "Background color chart" appears 
again.

Draw grid - 	 Select whether a grid should be displayed in the chart or 
not.

"Scaling" configuration field

Choose scale - 	 Here you can allocate the scale to a data display, e.g. 
Temperature.

Axis title - 	 This field is for entering an individual title for the respec-
tive data display.

Unit - 	 Select the unit of measure for the respective data display 
here.

Font color - 	 Select the font color for the respective scale, selection 
is the same as for "Background color 1".

Axis color - 	 as above, but for the scale axis.
Range
Auto range axis - 	 When this option is selected, the displayed range of scale 

values is automatically adapted to the actual values of 
the data in order to achieve the highest possible display 
resolution.

Show always 0 - 	 When this option is selected, the respective display is 
always shown in reference to zero, as long as "Auto 
range axis" is activated.

Upper/lower bound
of the scaling - 	 Here, you can define the limits for scaling individually.
- After selecting all settings, they can be transferred into the weather history with 

the "Accept" button or the "OK" button.
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2.3.4. Interface status
- 	 If you open this sub-menu, a status message window appears showing which 

sensors are registered on the interface in the top part:
	 "Available" - 	  Sensor is registered
	 "Not available" -  Sensor not registered or not available
Note:  Only the Combi sensor is available at this time.
The interior sensors of the interface (Indoor temperature, indoor humidity and 
barometric pressure) do not appear in this list, only the radio sensors are displayed.

The interior sensors of the interface (Indoor temperature, indoor humidity and   	
	barometric pressure) do not appear in this list, only the radio sensors are dis-
played.	 If there are errors in reception for individual sensors, these are shown 
next to the respective sensor.	

	 The displayed data can be updated by clicking the button "Refresh" at any time.
- 	The configuration of the interface is completed in the lower window.

Interval time -	 Defines in which intervals that data should be saved on the inter-
face.

	 Enter a value between 5 and 60 minutes here.
Height - 	 Enter the elevation of the location above sea level here  

(0 -6561 ft). This information is required for a precise barometric 
pressure calculation.

Rocker - 	 Enter the amount of water that would correspond with a pointer 
stroke for the rain quantity sensor if required.

	 The default value is 295. This value is only to be changed for a 
rainfall sensor calibration (see section "Rainfall sensor calibration"). 
See page 16 as well "Maximum change (in pointer strokes)".

Please note!
· The time synchronization 

transfers the PC system time to 
the weather station.
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- 	Button "Assign" is pressed to transfer the data of the settings to the interface 
after an acknowledgement prompt. The interface is then synchronized with 
the weather sensors again.

	 During the synchronization, a progress bar is displayed showing the elapsed 
synchronization time (percent of 10 minutes).	 If the synchronization has com-
pleted successfully, a corresponding message appears.

	 Confirm this by clicking on the button"OK".
	 If there was a fault in the synchronization, an error message appears. In this 

case, check the connection with the interface again and attempt a new transfer 
of the initialization settings.

Please note!
During the synchronization, the interface cannot be accessed. See
the information on synchronization in the operating manual of the interface as 
well.
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2.3.5. Sensors
- 	 This sub-menu is for making all settings that are important for the display in 

the weather display and the weather history for the respective sensor. There 
are different setting fields treated the same as the respective basic settings 
depending on the type of sensor, e.g. the color settings for the rainfall quantity 
display.

Choose sensor - 	 Selects the sensor to set the data for. Example: Rain
Sensor - 	 This shows the device that the previously selected sensor 

is in, e.g. Combi sensor.
Location- 	 Here, you can enter the location of the sensor. Currently 

not available, used for add on sensors.
Sensor name - 	 Here, you can assign an individual name for the sensor. 

Example: Temperature Outdoor
Short name - 	 Here, you can assign a short name for the sensor. Example: 

OD Tmp
	 (max. 5 characters), which will be used in the weather data 

table and in the navigation window.
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Line color 
in the graphic display - 	 Here,  the l ine colors for  th is  sen-

sor in the weather diagram are defined 
as described under "Weather history"  
(Configuration field "Display" "Background 
color 1").

Line width in the graphic display - 	 Here, you can select the line width for 
this sensor in the weather diagram.

Unit - 	 Here, you can select the desired unit of 
measurement for the selected sensor for the 
weather display. Example: F or C for tem-
perature

Period min/max - 	 Here, you can select the max./min. display 
period for this sensor. The current start for 
the min-/max recording is shown in the line 
underneath. The possible periods are "To-
day", the last 24 hours and since last reset.

Show minimum/maximum - 	 Choose whether the min-/max values are to 
be shown for this sensor or not here.

Reset min/max - 	 Pressing this button resets the min-/max 
memory. The min-/max memory is reset by 
actuating this button. As of this point in time, 
the new extreme value recording is begun.

Feature of the sensor "Rainfall"
In this case, there is a field for making calibration settings for the rainfall sen-
sor:

Maximum change
(in pointer strokes) - 	 A value of 255 is entered by the factory here. 

You can adjust this number if you feel the 
rainfall ist reading high or low. This definition 
prevents an unreal number of pointer strokes 
from being registered per measurement in-
terval (e.g. a number of 2000 pointer strokes 
at 295 ml in 10 minutes would be unreal for 
rainfall). 
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Choose weather display - 	 Chose the weather display to be edited here. There 
are three weather displays that can be arranged 
differently. These are to be allocated as desired 
to the displays for the individual sensors, e.g. one 
display only with the data of the external sensors, 
one only with temperature sensors, etc.

2.3.6. Weather displays
All settings for the start-up screen of the weather display can be made in this 
sub-menu. Every definition can be accepted and checked immediately with the 
"Accept" button at the very bottom as long as the respective weather display 
has been selected as the main display previously.

Note!
Only sensors 
recognized by 
the interface
can be selected!
Currently additional sensors
are not available.
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Weather display name - 	Here, you can enter an individual name for each weather 
display in the data field.

Background image  - 	 Here, you can select your own image in .png, .jpg or .gif 
format and use this as the display background. After 
actuating the button "...", the Windows file selection 
appears and you can search for and load the desired 
image. The image name appears in the previously 
empty name field.

Background image - 	 Here, you can define a color for the display background 
as described under "weather history", if no background 
image has been loaded ("Display" configuration field, 
"Background color 1").

Combi sensor - 	 By marking the individual sensors in this configuration 
field, you can select individual sensors of the Combina-
tion sensor for that data to be displayed in the selected 
weather display. 

Additional sensors - 	 All of the temperature-/humidity-sensors being received 
after the initialization are shown in this configuration 
field. Mark to select which of them should be displayed 
in the selected weather display.

Indoor sensor - 	 In this configuration field, you can mark the internal 
sensors of the base station to select which data should 
be displayed in the selected weather display.

Oscar Outlook - 	 This configuration field is used for choosing whether 
the Oscar Outlook should be displayed in the selected 
weather display.

- 	 After selecting all settings, they can be transferred into the respective weather 
display with the "Accept" button or the "OK" button.
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Period
The period that the weather data is for is shown above. You can edit the period 
for saving the data under "Choose period". This is done by marking the respec-
tive position, e.g. the minute position and entering the desired value with the 
keyboard or raising/lowering the value with the arrows next to the field. The date 
can be selected directly with the calendar to the far right in the line.

Save as 
Use the button "Choose file" to select the desired location and file name as well 
as the desired file format (CSV/SLK) to save the file under. 
Note:	 CSV is Comma Separated Values. SLK is Symbolic Link. A table calcula-

tion program, such as Excel, can open the file formats.
The file formats can be opened by a table calculation program.
After confirming the entry with the "OK" button, the file name and the storage 
location appear in the line behind "Save as".

Sensors
You can select the option "All sensors" or "Choose sensors" for saving.
If you select "Choose sensors", you can define which sensor data should be 
included in the data export by clicking on the desired sensors from Indoor, Combi 
and Additional sensor(s).
Note:	 Additional sensors are currently not available.
Saving is started with the "Start" button and completed with a respective mes-
sage.
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Please note!
If a file name is entered twice, the older file of the same name is overwritten. 
Therefore, a new file name is always entered if you wish to save the old data.

Print - 	 A printout of the weather history (weather dia-
gram or tables) is possible with this option. 

	 Define the desired layout information for printing 
in the preview dialog and start the printout as 
usual in Windows.

Save image - 	 This option allows you to save the current im-
age (weather display or weather history) as an 
picture in .png or .jpg format.

	 Select the desired save location, the file name 
and the type of file in the file dialog and save 
the image with the "OK" button.

Exit - 	 Ends the "WeatherProfessional" program.

2.4. The menu lines
2.4.1. The "File" menu
- 	All settings that affect data management and printing data are made from this 

menu.

Database - 	 Opens the sub-menu "Database" of the control 
center, see chapter "Control center".

Export weather data - 	 In this sub-menu, you can define which data 
should be saved over which recording period 
and in which storage location.

2.4.2. The "View" menu
- In this menu, all settings that affect the screen display of the program are 

made.

Weather display settings - 	 Opens the sub-menu "Weather display" of the 
control center, see chapter "Control center".

Weather data table - 	 Opens the weather data table, in which the data 
of the weather history is displayed in table format  
(see 2.6).
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Min/Max values -	 Opens the display for the min/max and aver-
age values for weather data for a selected time 
period.

	 On the left in the navigation field, you can se-
lect the sensors for which the data should be 
evaluated and displayed in the right-hand table 
field (see 2.6).

	 Minimum - Maximum - Average
	 Now you can select the time period for which min/max data should be re-

corded and for which the average value ø should be calculated.
	 On the right, the current date and the respective sunrise/sunset data is dis-

played for the defined location.
	 After accepting the selection with the "Accept" button, the calculated data 

will be shown in table format. The minimum value, maximum value and 
average value (ø) are shown for the selected time period (Exceptions: Wind 
velocity (no minimum); Rainfall (only maximum and quantity for the selected 
period)).

	 See chapter 2.6 as well (page 30).

Weather diagram settings -	 Opens the sub-menu "Weather display" of the 
control center, see chapter "Control center".

Update - 	 Updates the display corresponding with the 
data currently held in the database.

Tool bar/Status bar - 	 Turns the tool bar or the status bar on (click,  
checkmark) or off (click, no checkmark).

2.4.3. The "Weather Station" menu
- 	 The interfaces and weather sensors can be managed in this menu.

Interface status - 	 Opens the sub-menu "Interface status" of the 
control center, see chapter "Control center".

Sensor management - 	 Opens the sub-menu "Sensors" of the control 
center, see chapter "Control center".
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2.4.4. The "Display" menu
- 	The settings for the current display period of the weather history are made in 

this menu.

	 Select the desired display period. The weather reporting display is immediately 
adapted to the desired period.

	 With option "Next/previous period", a period before or after the relative selec-
tion is 
	 selected.	
	 Example: You have selected "6 hours" for displaying the last 6 hours, e.g. 6 to 12  
	 o'clock. By actuating "Previous period", you can now view the data for 0 to 6 o'clock, 
	1 8 to 24 hours of the previous day, etc.. With "Next period", you can then go ahead in 
	 6 hour display increments.

2.4.5. The "Tools" menu
- 	Various program settings can be accessed from this menu.

Control center - 	 Opens the control center, see chapter "Control  
center".

Export settings - 	 Saves the defined program settings in a selected 
save location.

Import settings - 	 Loads saved program settings.

Reset settings - 	 Deletes all user-defined settings.

Update WeatherProfessional - 	 This option can be used to load software 
updates. This requires an installed "Internet-
Browser" and an active Internet connection.

	 Start the downloaded update and follow the 
manual of the installation program.

Update firmware - 	 Found through Internet site shown in the dialog 
box for updating. 

	 Start the update and follow the instructions of 
the program.
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2.4.6. The "Help" menu
- 	 This menu provides access to this manual, an Internet l ink to 

the software download section of La Crosse Technology`s web site, 
and program information on the installed "WeatherProfessional"  
software (http://www.lacrossetechnology.com/support/software.php). 

2.5. The toolbar
- 	 Many menu functions are accessible with a simple mouse click in the tool-

bar.

1 - 	 Exit program
2 - 	 Update display with current weather
3 - 	 Save current display image
4 - 	 Print current display image
5 - 	 Display/hide navigator
6 - 	 Weather history display today
7 - 	 Weather history display period 1 hour (beginning with last hour)
8 -      Same as above 6 hours
9 - 	 Same as above 12 hours
10 - 	 Same as above 1 day
11 - 	 Same as above 1 week
12 - 	 Same as above 1 month
13 - 	 Previous period
14 - 	 Previous period
15 - 	 Zoom in on the weather history (decrease display period)
16 - 	 Zoom out from weather history (increase display period)
17 - 	 Reset to the originally selected display period after zooming, e.g. 1 day

2.6. Working with the displays, navigator
- 	In addition to the general weather data display, there is extensive additional 

information available for the displays, including the weather display and the 
weather history.

-  The navigator is either displayed by clicking on the navigator symbol (see 2.5) 
or by moving the separation bar left of the main display field. Roll bars for 
navigating in the window are located on the navigator windows.

1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 17
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- 	In the navigator, the views defined previously in the navigator for up to three 
weather displays, the weather history, a manual sensor selection in the weather 
history display, the display for the individual sensors in the history and the 
min/max/average display can be selected.

Weather display
- 	Click on one of the three available weather displays in the navigator. The dis-

plays defined previously in the control center appear as stylized instruments. 
The clothing status of the Oscar Outlook and the weather symbols in the Oscar 
Outlook display field indicate the weather forecast.  At night, the background of 
the Oscar Outlook appears in night-format, with the current phase of the moon 
as well. Read more detailed information in the appendix of this manual.
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Weather history
- 	 Click on either the "Weather history" line in the "Weather history" navigator 

itself or on any desired menu point under "Weather history". Here, the three 
defined weather display, a manual sensor selection, the display for individual 
sensors and the value table for the complete display of min/max values and 
the calculation for the average values are shown for the observation period.

	 Weather history
- 	 If you select "Weather history" alone, the "Sensor type" appears in the lower 

part of the navigator. Here, you can e.g. display the processing graphics 
for sensors of the same type, e.g. all temperature sensors and e.g. perform 
comparisons between different types of sensors (Temperature, ...).

- 	 To open the closed "Weather history" navigation menu again, click on the 
"Manual selection" option.
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Weather display
- When the "Weather display (1 ... 3)" option is selected, all data from of the 

selected display is shown as a trend curve in the report graphic.
	 At the same time, the instrument displays for the weather display appears at 

the bottom of the navigator window. By clicking on the individual displays, the 
trend display for this value is displayed/hidden in the report graphic:

	 Instrument background yellow: Value is integrated in the report graphic.
	 Instrument background white: Value is not integrated in the report graphic.
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Manual selection (in the navigation tree)
When selecting this option, the lower navigator window shows all of the sen-
sors that can be evaluated by the software. Click on the respective tab "Indoor 
sensor", "Combi sensor" or "Additional sensors" (Not available at this time) and 
select the desired sensors there. The data then appears as a trend curve in the 
reporting graphic.

Note
This option allows data that has already been recorded from sensors, that are 
currently not registered or physically no longer available and therefore not dis-
played on the weather displays, to be displayed since all data is stored in the 
database and can be called up from the database.
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Displaying individual sensors
When this option is selected, a sensor selection menu for selecting the sensor 
to be displayed is shown in the lower part of the navigation window. 
Underneath, you can select which average values for the displayed time-frame 
are to be displayed for this sensor to the right, next to the report graphic as a 
diagram marking (incl. fluctuation range). Only the maximum is displayed for the 
wind velocity and this display is not required for rainfall. 
The minimum and maximum are also displayed for the displayed time-range. 

Instead of a progress report graphic for rainfall, a bar chart can be understood 
better for rain quantities. In this case, the rain quantity is displayed per selected 
time period, with display "For one day" hourly from the 30th to the 30th minute, 
with display "For one month" daily from 7:30 o'clock to 7:30 o'clock (corresponds 
with the measuring time period for professional meteorology) and otherwise 
monthly or yearly.
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Additional info-display upon touching trend lines 
If you move the mouse pointer over the individual curves, a context-sensitive 
display appears for the points in time (corresponding with the recording interval) 
at which data has been recorded showing the sensor name, the time, the value 
recorded at this time and the values for minimum and maximum with the time 
point that the extreme occurred. 
After approx. 5 seconds, the context display disappears automatically.

Zoom functions
Next to the selection for the time period to be displayed (see 2.4.4./2.5) and the 
zoom functions (2.5) available from the tool bar, you can also zoom directly in 
the graphic. Use the mouse to drag a rectangle over the segment that you are 
interested in. The segment of the trend is automatically zoomed in on.

By pressing the right mouse key, the functions "Zoom in", "Zoom out" and 
"Auto-size" (return to full-time-period display) are available through the context 
menu.
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Minimum-Maximum-Average
If you select these options in the navigator, a table appears allowing all cal-
culations for previously recorded minimum and maximum, as well as average 
values.
The time period of the calculation can be selected individually.
The sunrise and sunset data for the current day is also displayed for the location 
defined in the control center (see 2.3). This is also the basis for the day/night 
Oscar Outlook background change.
-  Select the desired under options "For one day", "For one month", "For one year" and   
   "For all years" and then according to the desired month and/or the desired 
year.
- 	Select the sensors to calculate the data for in the bottom left.
- 	The calculation for the respective data begins with selecting "Accept". The 

progress of the calculation is shown in a progress bar.
- 	The results of the calculation are shown in the table.
-  The table can be printed out.
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Weather data table
Next to the graphic weather report display (weather history) option, the "Weather 
data table" option is shown in the display window.
The value progress is shown in table format here. For the selection of the data 
to be displayed, the actions correspond with those for the weather history.

- 	The table can be printed out.
-	 The values in this table can be edited with a double click. While making this 

entry, make sure that a decimal point is entered instead of a comma. Rainfall 
is the exception in this case. This cannot be edited. 
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3. Appendix Terminology

Barometric pressure history - Storage and graphic display for the barometric pres-
sure report. This can be used to make conclusions concerning the general weather  
development. The graphic display is in the weather display.

Weather trend - Forecast display with weather symbols in the weather display, 
calculated from the speed of increase or decrease in barometric pressure.
The change speed for barometric pressure is the decisive variable for predicting the 
upcoming weather, the absolute value plays a secondary role, see "Air pressure trend" 
as well. Generally, increasing barometric pressure means better weather and dropping 
barometric pressure means poorer weather. 
If the weather station is used e.g. with a laptop on a boat, you can predict whether a 
bad weather front is approaching and help to determine whether it is necessary to 
retrain from crossing a large body of water or to return to harbor, by using the change 
speed of the barometric pressure (normally confirmed by cloud formations, which boat 
operators should understand). This forecast can be used just as well for farmers, sport 
pilots, paragliders, model airplane enthusiasts, etc.    

Absolute/relative barometric pressure - The air in the earth atmosphere has 
a specific density defined in grams per liter. The limit of the earth atmosphere 
is a (relative) constant value. The earth surface however, including bodies of 
water, deviates between the deepest sea level and the highest mountain tops. 
As a result, there is a different air-"weight" in every area, depending on the 
height above an average sea level and the height of the air column over sea 
level. Therefore, the barometric pressure at sea level is much higher than at 
the top of the Himalayan mountains.  
To achieve a reference variable, most weather reports will either refer to the 
absolute barometric pressure in relation to average sea level (general definition, 
normally for a country) or for more detailed reports, a graduated barometric 
pressure is shown with isobars (the barometric pressure trend in more precise 
weather maps). In the second case, you can recognize the barometric pressure 
fronts very easily and understand more about the routes the fronts will take.
Since the weather station always shows the relative barometric pressure in a 
single location, a correction factor must be defined that makes indicating the 
difference between the absolute and relative barometric pressure however. 
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Wind strength table (Beaufort)

Beaufor	 Wind velocity km/h	 Wind velocity mph	 Description	
0	 0 - 0.7 km/h	 0 - 0.4 mph	 calm		
1	 0.7 - 5.4 km/h	 0.5 - 3.6 mph	 light air	
2	 5.5 - 11.9 km/h	3 .7 - 7.4 mph	 light breeze	
3	12 .0 - 19.4 km/h	 7.5 - 12.1 mph	 gentle breeze	

4	19 .5 - 28.5 km/h	12 .2 - 17.7 mph	 moderate breeze
5	2 8.6 - 38.7 km/h	1 7.8 - 24.0 mph	 resh breeze		
6	3 8.8 - 49.8 km/h	24 .1 - 30.9 mph	 strong breeze	

7	49 .9 - 61.7 km/h	31 .0 - 38.3 mph 	 near gale		
8	 61.8 - 74.6 km/h	3 8.4 - 46.4 mph	 gale			
9	 74.7 - 88.9 km/h	4 6.5 - 55.2 mph	 strong gale		
10	 89.0 - 102.4 km/h	 55.3 - 63.6 mph	 storm		
11	1 02.5 - 117.4 km/h	 63.7 - 72.9 mph	 violent storm		
12	 > 117.4 km/h	 > 72.9 mph	 hurricane	

Units 
°F 	 = [°C] * 9 / 5 + 32
°C	 = ( [°F] – 32 ) * 5 / 9	
mmHg	 = [hPa] * 0.75006	
inHg	 = [hPa] * 0.02953	
m/s	 = [km/h] / 3,6	 = [km/h] * 0,27778
Knots	 = [km/h] / 1.852	 = [km/h] * 0,53996
mph	 = [km/h] / 1.609	 = [km/h] * 0.6215
in	 = [mm] / 25.4	 = [mm] * 0,03937
ft	 = [m] /0.3048	 = [m] * 3,28084
cu. in.	 = [ml] / 16.387	 = [ml] * 0.061024

Wind-chill equivalent temperature (sensed temperature) - A fictive temperature 
that is felt by people under certain conditions instead of the measured tempera-
ture and e.g. can be used at low temperatures to indicate how comfortable one 
would be at certain temperatures, wind velocities and suitable clothing. These 
conditions are a temperature under 91.4 °F and a wind velocity above 5.8 mph. 
Wind-chill is defined as a cooling effect on unclothed skin at an accepted con-
stant of 91.4 °F skin surface temperature. 
The "sensed temperature" is comparable with the so-called felt temperature, 
which takes additional measured values into account. 
Dew  point - Temperature point that depends on the combination of a certain barometric 
pressure, a certain temperature and a certain humidity. At this temperature point, the  
humidity in the air begins to condensate, the so-called dew point, the atmospheric 
humidity condensates out and falls down as liquid.
Therefore, e. g. the dew point for air is at 17.4 g/m3at 68 °F water vapor. If the 
dew point for water vapor is under 32 °F then the condensation appears as 
snow or frost.
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Therefore, e.g. the dew point for air is at 17.4 g/m3 at 20 ˚C  water vapor. If the 
dew point for water vapor is under 0 °C then the condensation appears as snow 
or frost.

Comfort Indicator
-	The Comfort Indicator (LKJ) indicates the indoor air 
	 (ratio of temperature to humidity) (status of symbols indicates the range of 

validity):

Temperature	 air humidity

	2 0% 	3 0%	3 5%	4 0%	4 5%	 50%	 55%	 60%	 65%	 70%

<64.4 °F	 L	 L	 L	 L	 L	 L	 L	 L	 L	 L
64.4 - 67.8 °F	L	 L	 L	 K	 K	 K	 K	 K	 K	 L
67.9 - 71.4 °F	L	 L	 L	 K	 J	 J	 J	 J	 K	 L
71.5 - 75.0 °F	L	 L	 K	 J	 J	 J	 J	 K	 L	 L
75.1 - 78.6 °F	L	 K	 J	 J	 J	 J	 K	 L	 L	 L
78.7 - 82.2 °F	L	 K	 K	 K	 K	 K	 K	 L	 L	 L
over 82.2 °F	 L	 L	 L	 L	 L	 L	 L	 L	 L	 L

This shows that depending on the ratio of temperature to humidity, there are 
clearly differentiated ranges that are defined as comfortable or uncomfortable 
climates. This means we find e.g. at a temperature of 77 °F a humidity of 30% 
as too dry (e.g. heating air) and humidity over approx. 60% as muggy.
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Weather display "Oscar Outlook"
The behavior of this character is based on various weather factors; hence it is 
immediately possible to know the type of clothing one would need outdoors. Not 
only the current measured values for outside temperature, humidity, wind and 
rain are evaluated for this display. The weather forecast also plays an equally 
important role. Sodifferent displays and clothing depending on the weather situ-
ation are shown on the"Oscar Outlook":

Outside temperature (only combination sensor)
- 	The clothing status is based on how high the temperature is on the combination  

sensor.

Rain
- 	If the weather forecast has announced rain, then the figure holds a closed 

umbrella.
-  The figure carries an opened umbrella when it starts raining.

Wind velocity
- 	If the wind velocity is higher than 12.4 mph (medium wind) Oscar Outlook`s 

hair starts fluttering. At the same time, if the temperature is below 57.2 °F, then 
even the scarf he is wearing starts fluttering.

Weather forecast
- 	The weather forecast symbols above the Oscar Outlook present the following 

forecasts:

· Clouds with rain --> 	 Rainy
· Clouds --> 		  Cloudy
· Clouds with sun --> 	 Bright
· Sun --> 		  Sunny

Moon phases display
The moon phases are displayed using the following symbols:

Waning moon New moon Waxing moonFull moon



36


